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Lessons for Elementary Students: Grades 3-8 

 

 

Technology Project for 

PowerPoint 

Animate a digital story. 

 

Inspire writers to use their imaginations for storytelling. 

In this project, students create a digital story in the style of a cartoon or animated comic strip 

using Microsoft PowerPoint. To start, they learn about writing conventions and watch sample 

stories as a source of inspiration. Students then apply their creativity to construct their story with 

text boxes, images, callouts, starbursts, and shapes. Transitions are inserted between slides to 

divide the scenes. Animation is applied to objects to sequence the timing of events. Upon 

completion, the digital story is shared with peers. Challenging extension activities support 

learning with optional assignments such as picture editing, advanced animation techniques, or 

print options. Discover the fun your students can have with PowerPoint! 
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TechnoToon Overview 
  

Purpose: Engage in digital storytelling. Produce 

a cartoon or animated comic strip that tells a 

story using text, imagery, and animation. 

Preparation: (see Prepare to Teach) 

• Install Microsoft 365 

• Install Adobe Acrobat Reader  

• Share Toon folder with students 

• Download Flashcards and Tool Summary from 

TechnoHub (optional) 

 

Objectives: (see Appendix A: Skill Summary) 

• examine digital stories 

• select and organize story ideas 

• produce an original digital story 

• revise a story to improve quality 

• publish a digital story to share with others 

• insert new slides and select layout 

• format slide background for story backdrop 

• express ideas using text and shapes 

• illustrate events with images and objects 

• divide story action by applying transitions 

• animate slide objects to sequence events 

• set a digital story to play automatically 

Materials: (see Appendix B: for a complete list) 

• Digital Story Checklist, Peer Editing Checklist, 

TechnoToon Skill Summary, Digital Story Marking 

Sheet 

• Toon folder 

o Workbook Assignment Sheets 

o Samples: What is It; My Dream, Super Dog, 

Connection, PSA, Biography 

o Cartoon1 and Cartoon 2 templates 

• Parent Letter and Certificate (optional) 

• Flashcards and Tool Summary (optional) 
  

 

Summary of Activities: 

• Learn about digital storytelling, cartoons, and comic strips. Complete storyboard panels. 

• View sample digital stories as a source of inspiration. Answer questions about their content. 

• Use a planning sheet to draft story ideas. Organize events into panels. 

• Make a title slide. Format text and text boxes. Apply a slide background. 

• Set the scene. Create a slide with a picture background. Include a text box, character, and callout. 

• Create the remaining scenes. Include a starburst with text to emphasize an action. 

• Add transitions to divide scenes. Animate objects to control the timing of events and enhance story. 

• Complete a digital story checklist. Make revisions. 

• Share a digital story.  

 

Extension Activities: 

• Generate a Story Idea: Select a character, setting, and plot to generate a storyline. 

• Use Images from Internet: Learn about copyright. Save a background or WordArt. Insert onto slide. 

• Picture Editing Workshop: Crop, frame, and flip images.  

• Animation Workshop: Practice animation techniques by making a short story. 

• Print a Comic Strip or Comic Book: Print a handout with customized settings. 

• Make a Video: Output the digital story as a movie file. 
 

 

Assessment: 

• Self-Evaluation (Digital Story Checklist) 

• Peer-Evaluation (Peer Editing Checklist) 

• Teacher Evaluation (TechnoToon Skill Summary, Digital Story Marking Sheet) 
 

 

Notes: 

• Digital storytelling is a language arts activity. Activities follow the stages of the writing process. 

• The creative writing assignment can be kept simple. Use extension activities to challenge students 

with advanced skills. 
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Technology Integration Ideas 

Inspire reluctant writers with digital storytelling. The TechnoToon project integrates technology 

into language arts. Have your students use their imaginations to create a story that looks like a 

cartoon or animated comic strip. This is a fun creative writing activity that students will enjoy. 

 

TechnoToon can be used as a creative writing unit, an option for a book report, or as part of a 

novel study. Here are a few ideas! 

• Write an Original Story: Plan a story or simple scenario that has a beginning, middle, and 

end. Divide the action into panels. Use text boxes to describe the scene, callouts for 

characters to speak or think, and clip art to illustrate the action. (see What Is It sample) 

• Only a Dream: Create a dream sequence that shows a series of imaginary scenes. This is 

an easy way to plan a digital story. (see My Dream sample) 

• Illustrate a Wacky Scene: Have fun with a cliché or popular expression. Make a simple 

scene that explains what happens when pigs fly, there is a blue moon, or it starts raining 

cats and dogs. 

• Invent a Superhero: Create a character and give them a name and superpower. Have 

the hero save the day! Take part in a rescue mission, engage in an epic battle with a 

powerful foe, stop a crook, or retrieve a lost item. (see Super Dog sample) 

• Tell a Joke: Make people laugh! Use one slide to make a silly scene, two slides to show 

before and after clips, or several slides to tell a knock-knock joke. 

• Transform a Popular Story: Remake a nursery rhyme or fairy tale into a cartoon. Swap the 

characters, adjust the story line, or rewrite the ending to create a modern twist on an old 

favorite. 

• Retell a Story: Summarize the main parts of a story. Sequence the key events using slides 

as scenes. In the first scene introduce the characters and setting. The following slides 

illustrate the action.  

• Rewrite the Ending: Produce an animated scene that illustrates a different ending. 

Include a slide that explains why this ending is better than that of the author. 

• Makeover a Realistic Story into a Cartoon: Consider what a story would be like if the 

people were substituted for cartoon characters, the setting shifted to an imaginary 

place, but the plotline remained similar. Create a short, animated clip of the cartoon 

version. 

• Join the Action: Insert yourself into the story. What advice would you share? How would 

you help? Recreate a scene from the story. Use a clip art character, photo, or web cam 

image to put yourself into the scene. Does your advice or behavior change the ending? 

• Form a Connection: Reflect on the story. What connection do you have? Do you like the 

same things as the main character, have you shared a similar experience, or does the 

story remind you of something you have seen or read? Explain the connection and use 

evidence from the book or your life to support your ideas. (see connection sample) 

• Conduct a Character Analysis: How does the character change as the story unfolds? 

Create a three-panel animated comic strip. In the first panel introduce the character at 

the beginning of the story. Use callouts and textboxes to show their mood, describe their 

character traits, and explain their role within the story. In the second panel illustrate an 

important event that causes a change or growth within the character. In the final panel 

show the character at the end of the story. How are they different? 
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Assignment 2  View Sample Digital Stories 
 

   

 

Study Digital Stories 

 Open the Toon folder. 

View each sample and answer the questions. 

1. You can create a simple digital story using Microsoft PowerPoint with only a few images.  

Watch What Is It.  

 

 

     
 

 Finish the story differently. What else could have been in the box? 

  

 

 

2. Making a digital story is fun because you can use your imagination. With only a few 

images and simple animation you can make a story come to life. Watch My Dream.  

 

 

       
 

 What other things could you dream about that would make you happy? 

  

 

 

3. In a digital story, characters can be made to move and talk. Callouts help to tell the 

story. Watch Super Dog.  

 

 

    

 

 

 What character could you use for a super hero? What would be their super power? 

  

 

Watch 

digital 

stories. 

Each story was made using 

Microsoft PowerPoint. 

Get ideas for 

your own story! 
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Assignment 5  Set the Scene 
 

   

 

Open the Digital Story in PowerPoint  

 

 

Add a New Slide and Apply a Layout 

 Select the thumbnail of the first slide in the slide pane.  

 

 Click the New Slide arrow.  

 Pick Title Only.  

 
 

Introduce the Story Using a Text Box 

 Type inside the text box: 

 
 

 Format the font , size , style , ,  , , or color   of text. 

 From the Home tab, pick an alignment option.      

 From the Shape Format tab, set a text box style  , fill  , outline , or effect . 

  

You are going to 

make the first 

scene in your story. Refer to the 

planner you 

completed in 

Assignment 3. 

You will learn to 

insert images and 

make a callout. 

The Title Only layout has a 

text box that can be used 

to describe the scene. 
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Resize, Move, or Rotate a Text Box 

 Select the text box.  

Edit the shape and position of the text box:  

o Click and drag a handle IN or OUT to resize it.  

o Click and drag on the border of the text box to move it.  

o Click on the rotate handle and turn the mouse to change the angle.  

 

 
 

Add a Picture as the Slide Background 

 Click the Design tab. Click Format Background.  

 Select Picture or texture fill. Click Insert.  

 

 Pick Online Pictures.  

 In the search box, type background. Press ENTER.  

 Refine the search using the Filter  options.  

 

 Find a picture you like. Click on it and then click Insert. 

 Close the Format Background pane.  

Search Word Tips: Use these words or combine them with a search word to find a background. Make the 

word plural to change the search results. 

gradient fabric pattern paper texture 

wall wood background wallpaper abstract 

design scene scenery nature fantasy 

landscape scape painting art summer 

dark or light night colorful free stock 

watercolor presentation sketch vector drawing 
  

rotate 

move resize 

The picture you pick 

should be WIDE. 

Refine the 

search. Click  

and choose 

options. 
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Insert Character 

 From the Insert tab, click Pictures.   Pick Online Pictures.  

 In the search box, type search word. Press ENTER.  

 Click Filter.  Select Clipart to find cartoon images.  

 

 Click on a character you like. Click Insert. 

 

 Use your skills to resize  and move  the character.  

 

Draw a Callout to Make the Character Speak or Think 

 From the Insert tab, click Shapes.  

From the Callouts category pick a shape.  

 

 Click and drag to draw a callout. 

 Click inside the callout. Type what the character is saying or thinking. 

 

 Rest the mouse over the yellow handle.  

Drag it to change the direction of the tail.  

 

 Use your skills to resize   and place  the callout. 

 Click the Shape Format tab. Apply a style , fill , outline , or effect .  

What is your character saying or thinking? 

If your character has a colored 

background, from the Picture 

Format tab, click Color  . 

Click Set Transparent Color . 

Click the colored background. 
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Use Skills to Complete the Slide 

 Complete the first scene in your story.  

 Use text boxes and callouts to explain what is happening.  

 

 Use your skills to create the scene. 

 
 

 

 

Save and Close PowerPoint  

Story Making Tips: 

✓ Any shape  can have text added.  

✓ Use Pictures  and pick Online Pictures  to add objects 

to the scene. 

✓ Use the text box to describe the action. 

✓ Show your scene to a friend. Is there enough information to 

understand what is happening? 

✓ Copy  (CTRL + C) and paste  (CTRL + V) objects to quickly 

make a scene. 

Complete Extension Activity 2 

to learn how to save pictures 

from the Internet to use in 

your cartoon. 
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Be a Peer Editor (Optional) 

 

Watch a digital story. 

Complete the checklist. 

 

Story Quality  

The title attracts attention and tells about the story.  

The scenes combine to create a story that is interesting and makes sense.  

Content and Design  

The images used for the characters are suitable for the story.  

Text boxes are used to describe the action.  

Callouts are used to express what the character is saying or thinking.  

Objects such as starbursts and WordArt emphasize the story action.  

Slide backgrounds provide a fitting backdrop for a scene.  

Animations and Transitions  

Transitions divide the scenes.  

Animations suit the object and enhance the story telling.  

The animations are sequenced in a logical order.  

 

Comments – List one thing you liked about the digital story. 
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Extension Activity 1: Generate a Story Idea 

 

   

 

My Story Idea: 

 

Character Setting Event 

alien or monster jungle or woods holiday 

dinosaur ocean curse or spell 

robot planet explosion 

pirate tomb top secret mission 

superhero or villain temple or pyramid robbery 

unicorn cave disappearance 

genius castle escape 

mummy parallel universe time travel 

witch or wizard desert discovery 

spy north pole kidnapping 

vampire mountain party 

knight maze cure or virus 

 

Spark your imagination! Pick an adjective to describe your character or setting. 

brave ugly lazy invisible mythical 

jolly charmed weird shrinking frozen 

evil cryptic far away talking spooky 

 

Need more ideas? Pick a gadget or object to include in your story. 

doomsday ray teleporter freeze machine relic or amulet serum 

wand scroll mask spaceship sword or dagger 

Need an 

idea? 

Pick a character, 

setting, and event. 

Use them to think 

of a story idea. 
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TechnoToon – Digital Story Marking Sheet 
 

 

Story Quality  

• The title attracts attention and tells about the story. 

• The scenes combine to create an interesting story that makes sense. 

• All scenes are created in the style of a cartoon or comic strip. 

• Story idea is original. 

• Story is free of spelling and grammar errors. 

 

 /10 

Content and Design  

• The images used for the characters are suitable for the story. 

• Text boxes are used to describe the action. 

• Callouts are used to express what the character is saying or thinking. 

• Objects such as starbursts or WordArt emphasize the story action. 

• Slide backgrounds provide a fitting backdrop for each scene. 

 

 /10 

Animations and Transitions  

• Transitions divide the scenes and add interest. 

• Animations suit the object and enhance the story telling. 

• Animations are sequenced in a logical order. 

• The speed of animation is timed appropriately. 

• Animation is creative. 

 

 /5 

Comments: 

/25 

 




